
For use with application release March 11th, 2021 
 

CodySoft Review Process for 
Project Managers 
Contents 

Project Form ..................................................................................................... 1 

Project Requestor ............................................................................................. 1 

Creating and submitting a draft project ....................................................... 1 

Applying a saved project schedule template to a project record ............ 2 

Overview of the Review Process ...................................................................... 2 

Creating Rounds of Review in the Draft Template ....................................... 2 

Create Start and End Review tasks ............................................................... 4 

Starting the Template Review ...................................................................... 4 

Add or Remove Reviewers while in Review ............................................. 5 

Monitoring Reviews on the Reviews Tab ................................................. 6 

Reviews and Schedules ................................................................................. 7 

Marking up documents with the Markup Tool ............................................. 8 

Annotations Area ...................................................................................... 9 

Users Annotations Area .......................................................................... 10 

Navigation area....................................................................................... 10 

Complete review......................................................................................... 13 

Editing documents in Edit File .................................................................... 14 

Unlocking a file in Edit File ...................................................................... 14 

Reviewing the Review ............................................................................. 14 

Closing or canceling tasks ....................................................................... 14 

Creating another round of review .......................................................... 15 

Complete the Project ...................................................................................... 16 

 

Project Form 
Use the Project Form to create and submit a new project in the Collateral 
Management Module®. In the form, you can also upload attachments for 
your project. 

 

 
 

Project Form 

Project Requestor 
The first step in a CodySoft project is for the project initiator to submit a draft 
project, which must be approved by the Project Manager or Traffic Manager in 
charge. 
Creating and submitting a draft project 
 

1. From the dashboard, click New Project link on the right side of My 
Projects. 

NOTE: Items on the form with red asterisks (*) are required fields.  

2. On the Create Project page, enter the following information:  
a. Name: Enter a Name for the project 
b. Due Date:  Enter a project Due Date 
c. Line of business: from the drop-down list, select the 

checkboxes for the lines of business that apply to this project. 
d. Plan Name/C#/ID:  From the drop-down list, select the 

checkboxes for the contract numbers that apply to this project. 
e. Description:  Enter a brief Description of the project 
f. Media Type:  From the drop-down list, select the Media Type 

for this project. 
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g. Optionally click Add Attachment to attach any relevant 
document that applies to this project 

h. Click Save 
i. If you have Project Manager or Traffic Manager rights as 

defined in your CodySoft profile, the Details tab for the newly 
created project displays. 

a. Complete all required fields and any optional fields on 
the Project Overview, Project Services/Details, 
Printing and Distribution, and Requestor Info tabs. 

b. Click Save.  

j. Click Projects. Your newly created project appears at the top of 
the Projects list 

You will receive a notification email from CodySoft® that your project request 
has been submitted for review and approval.  
 
Applying a saved project schedule template to a project record 
 

1. In the Project Record, click the Tasks tab 
2. Click Edit to edit the project 
3. On the Tasks tab, click the Apply Project Schedule link. 
4. The Apply Project Schedule box appears. 
5. Select a project schedule from the drop-down list. 
6. Click OK. The project schedule/task list appears in the Tasks tab. 
7. Click Save. 

 
Overview of the Review Process 
Reviews can take place on both the Template and its draft plan documents, and 
also on the Versions tab documents created after the template has been 
approved and versions created. Projects managers monitor the progress of 
reviews and mark reviews as complete when all reviewers have completed 
their tasks, or when they want to start another round of review even if some 
users have not competed their tasks from a previous round of review. 
NOTE: You cannot start a review unless the project is in the In Progress state. 

Creating Rounds of Review in the Draft Template 
When you are ready to have your project documents reviewed, you create 
review tasks and assign them to the appropriate reviewers.  
 

1. On the Templates tab, click the Template Review icon on the row for 
the template you want reviewed: 

 
The Template Review dialog box opens.  
 

 
 

2. Enter the following information: 
a. Select whether the review is Routing or Concurrent. If you select 
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Routing, then each reviewer must review in the order you specify 
when you Add Assignments. If you select Concurrent, then 
reviewers you have assigned can review in any order 

b. Identify the Edit Method, either Edit File or Markup tool. The Edit 
File method opens the file in its original format, such as a Microsoft 
Word document for editing. NOTE: if the document you are editing 
is a PDF, you can only use the Markup Tool. 

c. Enter the predecessor task for this review. See Reviews and 
Schedules 

d. Enter the successor task for this review. See Reviews and Schedules 
e. Identify the document under review. The choices are Base template 

for review of the CodySoft editor template, or an individual plan 
from the list of plans in the project.  
NOTE: If you select to review a plan, the system does a merge and 
creates a draft template version of that plan with the rules applied 
to elements in the template, and data brought into the draft. If you 
select the review the base template, then the elements and rules 
appear without any processing. 

f. Click Add Assignment. The Assign/Edit Reviewers dialog opens. 

 
g. Identify the assignment or assignments for this round of review. 

This field is limited to 100 characters. Identify which review (for 
example “Review Round 2” and which plan (for example “H1234-
001”) is to be reviewed.  

h. Assign users by selecting from the dropdown list 
i. Enter estimated hours and minutes for how long the review should 

take to complete 
j. Enter a Start Date for the review 
k. Enter an End Date for the review 

3. Click OK. The Template Review page displays again, with the 
assignments, listed. 

If you have selected the Routing review method, then up and down arrows are 
available to change the order of reviewers. There are also Edit and Delete 
buttons to edit the task assignment or delete it. 
You can Save Project at any time on the Template Review page, and Exit Review 
at any time also. 
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Create Start and End Review tasks 
On the Tasks tab, create a start review (predecessor) task and end review 
(successor) task in your task schedule. You need to create both Start and End 
review bookend tasks. 

 
 
The tasks should have these characteristics: 

• Name the tasks appropriately to identify what is to be reviewed. 
For example, a task name might be Start Review Plan 003 if that’s 
the only plan you’re reviewing in this review. It’s also helpful to 
distinguish between template and version review tasks in the task’s 
names. 

• You can add dependencies to In Process Successor tasks. In other 
words, you can specify that the Successor task can’t be completed 
until the review tasks are completed 

Starting the Template Review 
1. When you are satisfied with the review specifics, click Begin Review. A 

confirmation dialog asked you to confirm that you want to begin the 
review. 
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2. Click OK. The Template Review Process Started information dialog 
appears. 

 
3. Click OK to stay on the Template Review page or click the underlined 

here link in the dialog box to return to the project 
Once this review begins, you can no longer add assignments to this review. 
Add or Remove Reviewers while in Review 
You can add or remove reviewers on an item already in review. 

1. From the Template Review Summary screen, click Update Assigned 
Reviewers: 

 
2. On the Update Reviewers dialog, use the dropdown list to add or 

remove reviewers for this review.  
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3. When you have made your changes, click Update Assigned Reviewers. 
The assignee list is updated on the Template Review Summary screen. 

 
NOTE: Click Close to exit the dialog box without making any changes. Also note 
that you cannot add remove a reviewer who has been assigned to a task and 
has completed that work. Their name will be greyed out in the Assigned To 
dropdown list. 
 
Monitoring Reviews on the Reviews Tab 
Use the Reviews tab to monitor review activity for both Template reviews and 
Version reviews. 

1. From the Projects page, click the Reviews tab 

2. Click either the Template reviews or the Version reviews tab to see the 
review activity for those stages of review. 

 
The Review Summary Section displays for the owner that initiated the review. 
The Review Tasks sections displays for reviewers assigned to the review. The 
Review Summary section shows Reviews in Progress and Reviews Completed 

3. Click Mark Complete to mark a review as complete.  
A confirmation message displays: 
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Mark Complete completes every open task with 100% progress but keeps the 
actual hours at 0 hours so that the user knows which tasks were auto-closed. 
Mark a review as complete when the review is over or when an additional 
review needs to replace the first review prior to the completion of that review 
 
The Review Tasks section displays reviews assigned to you.  
 
You can mark a task as complete by selecting the checkbox at the end of the 
row for that task. 
 
You can also go to the Tasks tab to see all Template review tasks assigned for 
this project. 
 
Reviews and Schedules 
The review process interacts with the task scheduler to keep the task schedule 
updated with the added reviews.  
 
Certain rules apply: 

• You need to have a start review task and end review task in your task 
schedule in order to create a review. These tasks are needed in the task 
schedule in order to have a predecessor and successor tasks for the 
review. 

• A reviewer must close out their own tasks during the review. 
• Any task that is a predecessor or successor should be named 

appropriately and relate to what is to be reviewed. For example, be 
sure to name tasks correctly to distinguish between template and 
version review tasks. 

• You can add dependencies to In Process Successor tasks. 
• The system will close out the predecessor task and will handle the 

dependencies on any tasks and successors. The predecessor and 
successor tasks are assigned to the same project manager that created 
the review. The system will close out the predecessor task but it is up 
to the project manager to close the successor task for each round and 
create a new successor task for each new review round so that the 

schedule continues to track correctly through the calendar dates. 
• The calendar feature in review task creation does not allow you to 

choose an end date that’s beyond the due date of the successor task. 
Your task end date cannot exceed the due date of your selected 
successor task. You can adjust the schedule to accommodate this 
situation. 

• Make sure your review tasks names are unique so that you can identify 
them easily 

• If you are the project manager, you need to keep track of the sum of 
assigned hours in a routed review or the sum of hours in a single task in 
a concurrent review. These hours must not cause the task to exceed 
the successor’s due date, or you will not be able to continue with the 
task creation. 

• When you click Begin Review to start a review, the chosen predecessor 
task automatically completes to 100% and all subsequent review tasks 
have a start date based on whether the review was routed or 
concurrent. Assigned reviewers are notified automatically when it is 
their turn to perform a review. When they complete a review are done, 
they close out their review task in the Task Schedule.  

• Once all review tasks are complete, or when you need to replace the 
first round of review with another regardless of whether previous 
reviews were completed, click Mark Complete on the review summary 
screen to close out any open tasks. 

• The “End Round X and Begin Round X+1” task is created automatically 
by the system when you mark a previous round of review as complete. 
It populates with the appropriate dependency based on the last review 
task assignment from the review that was just closed. For example, if 
you close out Round 1, the auto-added task reads “End Round 1, Begin 
Round 2”. The start and end date of the new task default to the date 
you mark the review as complete. This gives you a new predecessor 
task if you want to do another round of review. If you are not doing any 
more rounds of review, then you can simply rename this task and close 
it. 

• The auto-created “End Round X and Begin Round X+1” task becomes 
the dependency for the already existing successor task for the next 
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round of review. This creates the necessary beginning and end task 
date boundaries for rounds of review within a project, to keep the 
schedule dates in line during multiple rounds of review. When a round 
of review is marked as complete, the schedule has a new predecessor 
and same successor to use for the next round of review. That successor 
task that is created at the beginning remains and is always updated 
automatically using dependencies. A project manager always chooses a 
new predecessor that the system auto-creates for each additional 
round of review, and continues to choose and use the same successor 
task because the system auto-updates the successor’s dependencies to 
keep it pending as the last task in the review.  

To summarize, if you have a project with prior review(s), and you need a new 
review:  

o Do you have an End Round X, Begin Round X+1 bookend from a 
prior review? 
 If No, verify the prior round was Marked Complete.  
 If Yes, no need to create new Start bookend. Use the 

End Round X, Begin Round X+1 bookend from a prior 
review 

o Are the End Review bookend dates (start and end) greater than 
or equal to today’s date?  
 If Yes, no need to create new End Bookend 
 If No, you will need to create a new End Bookend task 

o If you have more Reviews to send out, but have no Start 
Bookend task then you will need to create additional start 
bookend tasks  

Marking up documents with the Markup Tool 
The PDF Markup tool is an easy-to-use editor that provides document 
reviewers with a simple interface to make edits: 

 
The screen is divided into three main areas: 

• Annotations area – The center area where you add annotations 

• Users Annotations section – On the right, where all annotations made 
to the document are listed. 

• Navigation area – On the left, available by clicking the arrow to expand 
it, where you can navigate through the document, filter the 
annotations, chat with other reviewers, and export your annotations. 
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Annotations Area 
Adding an edit or comment is as easy as clicking in the annotations area. 

1. Click, or click and drag to identify a section where you want to make an 
annotation. As soon as you click, the annotations dialog box displays: 

 
2. Click the HIGHLIGHT dropdown to change the annotation type. The 

dropdown list displays the choices for annotation type: 

• Highlight—marks the text with highlight 

• Underline—marks the text as underlined 

• Insert—allows you to insert text in the annotation 

• Strikethrough—marks the text as strikethrough 

• Edit—copies the selected text into the annotation for editing 

• Mark section—to mark an entire section for annotation. 

3. Enter text in the text box that describes the annotation, for example 
“Check plan types” or “Update contract year.” 

4. Click the TO dropdown in the upper left of the dialog box to select 
whether to make the annotation visible just for yourself or for all users 
assigned to the review. 
Optionally select one of the tags to enable you and other reviewers to 
narrow the annotations to a subset, for example, Benefits questions. 
Your system administrator sets up the appropriate tags for your use. 
Highlight color is based on the tag type: 

o Benefits in purple 

o Comments in red 

o Questions in green 

5. Click Save to save your annotation or click Cancel to cancel your 
annotation. 

The tool uses your last selection of annotation type for the next annotation. 
You can change the type when you make the next annotation. 
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Users Annotations Area 
The Users Annotations area keeps track of your annotations and those of 
others: 

 

If more than one person is reviewing the same document, their annotations 
appear in real time while you are in the review. 
You can reply (add a comment) to an existing annotation in the document, and 
edit an annotation you have made: 

 
NOTE: You can only delete annotations you have made, not the annotations of 
others. 
Navigation area 

Navigation 
The Navigation area provides many tools for working in the review: 

 
In the upper left of the Navigation area you can page through the file using the 
left and right arrows or enter a page number to jump to that page. Several 
menu choices provide additional functionality. 
View menu 
From the View menu you can choose where to show the Notes, or to hide 
them, and you can also access a view of all pages as thumbnails for navigation 
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purposes. 

 
Window menu 
From the Window menu you can change your view of the annotations by 
zooming in or out or setting the view to fit the width or the page size or rotate 
the page view. 

  
Tools menu 
From the Tools menu you can use the Find functionality to search the 
document, locate Word bookmarks, or bring in material from the Clipboard. 

 

Chat 
The Chat choice enables you to chat with other users who are on the review. 
This feature is useful for real time conversation about a document. Chats are 
not saved in the Markup tool. 



   

12 
© Copyright 2020 Cody Consulting Group, Inc. All Rights Reserved. Patent Pending. CODY’s Collateral Management Module does not relieve users of responsibility to understand and comply with applicable federal regulations. 

Notes 
The Notes choice gives you the opportunity to Filter the list of annotations by 
date, by tags, and by authors of annotations. You can find notes using a search 
bar and group the notes by various elements also. 
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Sizing icons 
The review space provides these additional navigation tools: 

• The plus or minus looking-glass icons  increase or decrease 
the display of the annotations area. 

• The sizing dropdown  gives you a set of choices for 
resizing the annotations area 

• The vertical double-arrow  positions the entire annotations area 
vertically as a single page 

• The horizontal double-arrow  positions the entire annotations area 
horizontally as a single page 

 
Complete review 
Click Exit Review to leave the review without completing it. All changes you 
have made during the review session are saved automatically.  
When you have made all annotations and added all comments to other 

reviewers’ annotations: 

1. Click Complete Review to end your review. The Confirm Commit 
Changes dialog box displays: 

 
2. Enter the time you spent on the review. 

3. Click Commit. 
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Your changes are committed to the database and available to the document 
creator or project manager, and the task is marked as complete automatically. 

Click the eye icon  on a completed task to see a PDF of the completed 
review file with all collated markups or click the .CSV icon to download a 
.CSV file of the comments in Excel format. 

 
When all reviews in a round of review are complete, it moves to the 
Completed reviews section. 

 
Click the template name on a completed review to see a PDF of the completed 
review file with all collated markups.  

 

Editing documents in Edit File 
If the review is Routing and the Edit Method is Edit File, click Edit File from the 
Review tasks section on the Reviews tab page. The document opens in 
whatever format the document was created. This might be a Microsoft Word 
file, an Excel spreadsheet, a graphic image, or several other formats. If you are 
working in Microsoft Word, be sure to turn on Track Changes so that other 
reviews can see your changes. 
NOTE: If more than one reviewer is assigned an Edit File review, the file is 
locked by the first person who opens it; only one person can edit the file at a 
time. You’ll need to wait until the file is available for editing. 

Unlocking a file in Edit File 
As project manager, you may have to unlock a file occasionally, for example, if 
someone started to edit a file and then went on vacation without completing 
the task. 
 
From the Unlock File column on the Review Summary, click Unlock. 

 
The file becomes available for review by others. 
NOTE: As project manager, be sure to use Unlock File only when you have a 
valid request or reason to do so. If another user has the file open, and you 
select Unlock File, the person who has the file open will have to save a local 
copy of the file. 
Reviewing the Review 
rom the Template Review Summary page, click on the Review Name to see a 
summary of the review in progress: 

 
Click Download PDF with applied Markups to see the marked-up document 
with all reviewers’ markup applied and the reviewer’s name below the 
comments that made.  
Click Download Notes CSV to download a .CSV file of the comments in Excel 
format.  
Closing or canceling tasks 
As a project manager, you may encounter circumstances where you want to 
close or cancel a task that has been assigned. You take these actions on the 
Tasks tab: 

1. Select a project 
2. In the project, go to the Tasks tab 



   

15 
© Copyright 2020 Cody Consulting Group, Inc. All Rights Reserved. Patent Pending. CODY’s Collateral Management Module does not relieve users of responsibility to understand and comply with applicable federal regulations. 

3. On the tasks tab, click Edit in the upper right to edit the project. All 
tasks for the project display: 

 

 
4. While you are editing the project, you can cancel a review task (the 

trash can icon) you have assigned or mark it as complete (select the 
checkbox) on behalf of the reviewer. For example, if you have an 
employee who has left the project, you may want to cancel that 
person’s tasks. 

5. Take one of two actions: 
a. Click the trash can icon to cancel a task 
or 
b. Select the checkbox to complete the task, and follow the 

steps to enter time spent 
6. Click Save to save your changes. 

Creating another round of review 
When all tasks from a previous round of review are marked complete, then the 
review icon displays again on the template on the Templates tab. 

Click the Review icon to start another review. If the system detects that you 
have done a previous review, the Previous Review Round dialog displays. 

 
 
This dialog allows you to copy the tasks and assignments from a previous round 
of review. If you select Yes, the previous review’s data is uploaded for the next 
review. You can then edit that information. If you select No, the Template 
Review screen displays. During the review creation process, if you want to exit 
the review screen, you can save the work you’ve done before exiting by clicking 
Save Review. When you return to the review screen, there is a Load button on 
the Template Review screen that allows you to load the work you had saved 
previously.  
 
There is also a Load button on the Template Review screen if you decide at that 
point to copy in the previous round’s review data. 
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Complete the Project 
After the all the tasks in your project have been completed, change the project 
status from In Progress to Complete status to archive the project. 

1. From the home page, choose the project you want to complete 
2. Click Edit 
3. Change the Status to Complete 

The project is archived automatically. 
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